SuccessFactors How-To

Run Onboarding to be Initiated Report

Overview

This report displays a list of the employees who are currently located in the Hired in SAP folder within the SAP segment
of the Talent Pipeline. The information can be used to determine which employees require Onboarding to be initiated.

Procedure

1. Click the Home menu and select Reporting from the drop-down.

Home

Careers
Recruiting
COnboarding
Company Info

Crarrs

Admin Center

'y =08

The Report Center screen appears.

2. Click Onboarding to be Initiated in the Name columns.

’é\-l : sporting _ ‘El

~ SAP SuccessFactors O

Home / Report Center

Report Center

£ -

[(] Switch to Classic View

(O View Schedules L7

Name Author Last Modified Type Action
| Onboarding to be Initiated &3 | Recruiting Admin May 23, 2018, 4:06:57 PM Report - Table :
Seniority Report 23 Recruiting Admin Dec 8, 2017, 4:06:57 PM Report - Table
Ready To Onboard .S% Braden Meikle Nov 23, 2017, 1:46:49 PM Report - Table §
Ready for Letter of Offer 22 Braden Meikle Nov 23, 2017, 1:34:31 PM Report - Table
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The Execute Onboarding to be Initiate... pop-up window opens.

3. Click the Export radio button and then select Excel from the Format drop-down menu.

4. Click Generate Report.

Execute Onboarding initiated

Run Online Download (C3WV)
Run Offline m—P> (8| Export
> [ 1113

Excel

Cancel Generate Report

The Opening report pop-up window opens.

5. Ensure the default selection, Open with Microsoft Excel displays.

6. Click OK.

-

Opening report_Cnbeoarding_to_be_Initiated--winnipeghcP--00010430... I&

You have chosen to open:

& ...cP--00010480--_claal2c1-178-4654-8f3a-665e7a340106.xls

which is: Microsoft Excel 97-2003 Worksheet
from: https//reportl7.zapsf.com

What should Firefox do with this file?

i | Microsoft Excel -

i) Sawve File

[] Do this autemnatically for files like this from now on.

] | Cancel |
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9.

The Microsoft Excel pop-up warning message opens.

Click Yes.

Microsoft Excel léj

The file you are trying to open, ‘report_Onboarding_to_be_Initiated-—-winnipeghcP—000 10450 _a&4cd006-56 27-458 3d-a4f-460720969595. 08, is in a different format than specified by the file extension. Verify that the file is not
l % corrupted and is from a trusted source before opening the file. Do you want to open the file now?

I ‘fes ]I[ Mo ] [ Help ]

The report opens in Excel and the Protected View message displays in a yellow bar at the top.

Click Enable Editing.

‘o Protected View  This file originated from an Internet location and might be unsafe, Click for more details. I Enable Editing I

Create a new worksheet tab and name it ONB Data.

43

M 4 » M| Report [ ONB Data |¥J
Ready | 3 |

10. Click the Home menu and select Onboarding from the drop-down.

CL Search for actions or people

Careers

Recruiting

+' Onboarding S

Comnany Info

The Onboarding Dashboard appears.

11. Click Advanced Reports.

The existing instance of the report will display in the list of reports, and must either be deleted or renamed before a
new report is generated.

12. Click the row for the existing report, and then click Delete.

Home Reports Documewter My Profile

Reports | Advanced Reports | Signature Transactions ‘

g =5 [3 &

= =

Creatg Delete TJo Excel Refresh

Report Name Date Created Date Completed Status Report Scope Report Owner Progress
ONB Time to Complete 6/21/2018 7:29:35 PM £/21/2018 7:31:06 PM Completed Public sf_hrss_wrha
Onboarding [nitiated 3 1/12/2018 2:52:58 PM 7/12/2018 2:56:19 PM Completed Public 00010480 [

I Onboarding to be Initiated 71242018 1:38:48 PM 712412015 1:41:40 PM Completed Private sf_hrss_wrha | 100% | I
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13. Click Create.

Home Reports Document Center My Profile

Reports | Advanced Reports | Signature Transactions

= |

Create | Refresh

Report Name Date Created Date Completed Status
ONB Time to Complete 6/21/2018 7:29:35 PM 6/21/2018 7:31:06 PM Completed
Onboarding Initiated 3 TM2/2018 2:52:55 PM TM212018 2:56:19 PM Completed

The Step 1: Set Report Parameters pop-up window opens.

14. Enter Onboarding to be Initiated in the Report Name field.

15. Ensure the remaining settings for Report Scope, Based on Template, and Report Template match the ones displayed
below.

16. Click Next.

Step 1: Set Report Parameters

Report Name: IDnbcarding to be Initiated

Report Scope: ® Private O Public

Based on Template: vl

Report Template: Onboarding to be Initiated - Private

Cancel

- p
Mext = ]
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The Step 3: Set Report Filter pop-up window opens.

e Required report fields will appear prepopulated based off of the report template you selected above.
17. Click Next.

Note: Do not enter any data in this window.

®

Step 3: Set Report Filter

Process: [~ Date Type: Start Date -]

From: =~ To: =

Select Field Operatar Condition Value
_] More Than |E|| |nb And ©Or
| add | Edt | [ Delete |
<= Back | Next = | Cancel

The Step 4: Save Report as Template pop-up window opens.
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18. Click Finish.

Step 4: Save Report as Template
MNow you are able to create the Report. You can save the current report as a template before you finish the
wizard.

Template Name:
Template Scope: @ Private © Public

| Save Template :I

=< Back Finish Cancel

You return to the Advanced Reports screen.
19. Click Refresh.

e You will see a progress bar on the right of the report row, this determines what percent of the report has been
created. Continue to click refresh until the status is 100%.

£y  Onboarding + Search for actions or peop , <5 Ron Anmroval behalfof _ SAP SuccessFactors

Heme Reports DocumentCenter My Profile

Reports | Advanced Reports | Signature Transactions

=N

Create |Refresh

h

Report Name Date Created Date Completed Status Report Scope Report Owner Progress

OMNB Time to Complete 6/21/2018 7:20:35 PM 6/21/2018 7:31:06 PM Completed Public sf_hrss_wrha
Onboarding Initiated 3 7/12/2018 2:52°58 PM 7/12/2018 2°56:19 PM Completed ~ Public 00010480
Onboarding to be Initiated 7/24/2018 1:38:48 PM 7/24/2018 1:41:40 PM Completed Private sf_hrss_wrha
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20. Click the row for your report and then click To Excel.

Home Reports Document Center My Profile

Reports

Create Delete [To Excel|Refresh

Advanced Reports | Signature Transactions

Report Name Date Created Date Completed Status Report Scope Report Owner Progress
ONB Time to Complete 6/21/2018 7:29:35 PM 6/21/2018 7:31:06 PM Completed Public sf_hrss_wrha [
o ot fa) op 0 qp ato w) i 2 [ 1o0% |

(15 2-52-58 Phg 018 2-~6- Il gmoleied b

An Exporting... pop-up message opens.

21. Click OK.

The page at https:/lonboarding17.sapsf.com says:

Exporting this file will cause the report with sensitive data to be cached to your local disk. Are you sure you want to do this? Click OK to continue, Cancel to cancel.

| Ok ]l [ Cancel

The Opening Excel pop-up window opens should auto select Open with Microsoft Excel. Select OK.
Note: Ensure the default selection Open with Microsoft Excel displays.

22. Click OK.

[ = ]

You have chosen to open:

ExcelReport.csw
) po

which is: Microsoft Excel Comma Separated Values File

from: https://onboardingl7 sapsf.com

‘What should Firefox do with this file?

@ Openwith | Microsoft Excel (default) hd

i) S5awve File

[7] Do this automatically for files like this from now on.

oK | — |
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Excel opens and displays the report.

23. Copy all data from the Onboarding to be Initiated report and then paste it into the ONB Data tab you created
within the Recruiting report.

24. Click the Report tab found in the Recruiting Excel report.
25. Select cell J2 and then click on the Formulas tab in the Excel ribbon.

26. Click Lookup & Reference and select VLOOKUP from the drop-down menu.

TR N s B s e 000
File Home Insert Data Acrobat

Page Layout Formulas Review View Developer

ﬁ z @ @ i El ﬁ ﬁ ﬁ m 2 Define Name ~ %iaTrace Precedents 3] Show Formula
L
= Use in Formula "‘Cf Trace Dependents @ Error Checking
Insert AutoSum Recently Financial Logical Text Date &) Lookup & | Math Maore Mame

Function - Used = - - - Time ~| Reference = [ Trig * Functions * | Manager B Create from Selection ,1‘2, Remove Arrows ~ @ Evaluate Formi
Function Library Defined Mames Formula Auditing

ADDRESS
AREAS
CHOOSE
COLUMM
COLUMNS
GETFIVOTDATA
HLOOKEUP
HYPERLIME
INDEX
INDIRECT
LOOKUP
MATCH
OFFSET
ROW
ROWS

RTD
TRAMSPOSE

—» VLOOKUP %
J=  Insert Function...
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The Function Arguments pop-up window opens.

27. Click in the Lookup_value field
and then click Column header A.

28. Click in the Table_array field, then
click the ONB Data tab and select
all data found in the tab.

a. Entera$ (dollar sign)
between the Column letter

and Row numbers.

W 9-0-=
Home Insert

Function Arguments

2 it

VLOOKLP

Lookup_value

Table_array

AtA
'OME Data'lA$1:D5B500

8678
{"JobRegld”, Employeeld”, Firsthame",’

Col_index_num
Range_lookup

Looks for a value in the leftmost column of a table, and then returns a value in the same row from a column you
specify. By default, the table must be sorted in an ascending order.

Faormula result =

Help on this function

Table_array is a table of text, numbers, or logical values, in which data is retrieved.
Table_array can be a reference to a range or a range name.

Page Layout Formulas Data Review View Developer Acrobat
ﬁ Z @ @ @ IL’Q ﬁ ﬁ @ m 53 Define Name - f:ﬁTTra:e Precedents 3 Show Formulas j W‘ @ calculste Now
= £ Use in Formula E('.:Tra:e Dependents @Errorchecking - A= L -
Fundion e Useae e e I Y Retrence~ & Trig~ Fundions | Manager BB Create from Selection | 7, Remove Artows « (@) Evluate Formula | window | Options + 2 <112t Sheet
Function Library Defined Names Formula Auditing Calculation
J2 hd fx
| A4 | B c D E F G H
1 JobRegID Employee ID Legal First Name Last Name Job Start Date HR Shared Services Team HR Shared Services Team |Last Status Change Date
ﬂas?a "Bo06a594 Marlon Salas 712712018 Pamela Prashar TI232018 9:58:24 AM
3 8501 Doo62213 Rebecca Bajus 713012018 Ketankumar Patel 712312018 10:13:36 AM
4 8541 Darrin Michaluk FI7i2018 Pamela Prashar 712312018 10:47:53 AM
5 9397 Vanessa Walton 6/15/2018 Stephanie Ridley T123/2018 10:50:59 AM
6 3620 0025546 Erwin Gestuvo 712412018 Ketankumar Patel TI232018 10:50:16 AM
7 19702 Melissa Hadden 711612018 Pamela Prashar 12312018 9:31:47 AM
g 8297 Jenica Jacques 712412018 Arlene Oystreck 712312018 11:03:23 AM
g G466 Angelica Kempa 7/125/2018 Pamela Prashar Ti23/2018 11:09:15 AM
10 7272 sneha mathew 5/4/2018 Pamela Prashar TI23I2018 11:17:25 AM
11 (1279 Doo41620 Leanne Marsch 212712018 Pamela Prashar 41172018 10:48:05 AM
12 (9710 "boo70789 Andrew Rambarran 712012018 Arlene Oystreck 712312018 11:59:53 AM
13 9467 "b0062335 Mike Jolicoeur 8/5/2018 Pamela Prashar Ti23i2018 12:17:38 PM
14 | 9556 Leah DePape 6/28/2018 Jilldene Moore TIG2018 10:46:59 AM
15 (6192 nettie friesen 5/15/2018 Pamela Prashar 5M5/2018 3:25:10 PM
16 |5728 "Do024a70 Julia DaCosta 6/5/2018 Ketankumar Patel 6i12/2018 4:24:17 PM
17 | 7650 0028037 Darlene Warcimaga 71312018 Stephanie Ridley 7i20/2018 4:09:55 PM
18 8744 0064345 Chantalle Lapointe 7H13/2018 Arlene Oystreck TI23/2018 2:39:32 PM
19 (3129 "Doosg029 Ericka Magnaye 4/28/2018 Stephanie Ridley 5M1/2018 9:18:33 AM
20 |9756 "boo10332 Glenda Rempel 71312018 Stephanie Ridley TI2312018 9:06:41 AM
21 |9579 Sanjida Newaz 5/21/2018 Jilldene Moore Ti23i2018 8:50:58 AM
22 9164 "boooan14 Laura Kutcher 712712018 Meghan Aguiar TI232018 4:33:56 PM
23 (8136 Do021251 Sonia Pires Couto 712712018 Micholas Ross TI23i12018 5:08:44 PM
24 (9395 "D0026846 Domenico Zappia 712712018 Jean Storey 712312018 5:36:53 PM
25 &709 00040701 Kelly Bader 772018 Pamela Prashar THO2018 10:34:14 AM
26 8754 Bo070319 Michael Pastrana 712712018 Larize Gaspar Ti24i2018 7:21:02 AM
27 (9840 "boo06243 Vincent Lobo 61712018 Larize Gaspar TI24i2018 7:56:28 AM
g |2802 Paige Boddy 5/28/2018 Pamela Prashar 52212018 11:19:15 AM
29 8563 Wendy Beaman 6/29/2018 Larize Gaspar THO9/2018 9:58:43 AM
30 7491 "bo022291 Alana Monaster 712112018 Stephanie Ridley TIZ32018 7:38:01 AM
31 (8343 "Do066244 Melvin Gonzales 6/29/2018 Larize Gaspar TI2312018 7:58:16 AM
32 (4305 "Dooz6074 Brittany Delarme 5/5/2018 Jean Storey 6/25/2018 10:47:33 AM
33 5162 "Bo024942 Joshua Qdufuwa 5/19/2018 Meghan Aguiar 51262015 1:24:10 PM
34 8443 0021950 Sheenqui Espaldon TI27I12018 Larize Gaspar THO2018 10:57.43 AM
35 [7436 "oooEg125 Shea Kosokowsky 5/21/2018 Jean Storey 5i29/2018 7:31:38 AM
35 (6522 "boogas09 Joymee Ceballe 5/2212018 Krystine Fajardo 5/26/2018 12:54:00 PM
37 | 7415 Mervin Pagulayan 7/16/2018 Pamela Prashar TI20/2018 10:39:40 AM
33 7068 Inderjit kaur Sidhu 8/ai2018 Jean Storey TH/2018 11:35:22 AM
39 5401 00067938 Vanessa Figueiredo 6/1/2018 Pamela Prashar 529/2018 11:22:45 AM
ap | 2209 "D00GETI6 Temitayo Raji 2/14/2018 Jean Storey 212112018 1:58:33 PM
41 (2203 Melanie Chapple 772018 Pamela Prashar TH1/2018 91718 AM
a2 (7501 "boosaras Kenora Athanaze 6/1/2018 Krystine Fajardo 6142018 10:19:42 AM
a3 | 7752 "bo022789 Antonette Castro 6/22/2018 Arlene Oystreck 6M15/2018 Z:21:44 PM
4 4 » M| Report - OMB Data . ¥J |I| 4|
Ready | 4 |
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29. Click in the Col_index_num field and enter the number.

30. Click in the Range Lookup field and enter FALSE.

31. Click OK.
Function Argumenis . I. 2 -';h]
VLOOKLIP

I
#
I

Lookup_value |A:A 3673

Table_array 'ONB Datz'A$1:D%3500 F&:| = {JobReqld”,"Employeeld”, FirstMame™,’
Col_index_num |2 || = 2
Range_lookup | FALSE| f|| = FaLsE

VLOOKUP(A:A,'ONB Data'\A51:053500,.

Looks for a value in the leftmast column of a table, and then returns a value in the same row from a column yau
specify, By default, the table must be sorted in an ascending order.

Range_lookup is a logical value: to find the dosest match in the first column (sorted in
ascending order) = TRLUE ar omitted; find an exact match = FALSE.

Formula result = YLOOKUP{A:A,'ONB Data'l A51:053500,2,FALSE)

Help on this function 0K Cancel

32. Click on Cell J2 and then,
a. Click and hold the solid black square in the bottom right hand corner.
b. Drag it down to the last line of your data.
Note:

Column J: If an N/A is found in column J this means that there is a candidate in recruiting that does not exist in
Onboarding, this meaning these candidates need to be onboarded and moved to the Hired folder or decision made
not to Onbaord and move the candidate to the Hired Folder.

Column B (Employee ID): A blank in column B means that this employee is an external and they required
Onboarding to be initiated.
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